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Getting Started

Opening New and Previous Logbooks

After installing Ship’s Log, you will be greeted by a Welcome Screen asking you to open

a previous logbook or create a new one.

e If you already have a logbook stored on your computer from a previous version of
Ship’s Log, you can use that file with the new version.

* If you are creating a new logbook, it is recommended that you name the logbook
after your vessel for quick and easy reference.

* When you open Ship’s Log in the future, the program will automatically load the
most recently used logbook.

Navigating the Main Menu

The twelve buttons on the Main Menu provide direct access to all parts of your logbook
with a single click of your mouse.

Above the menu buttons is the Main Menu Toolbar, which provides access to various
program options including Quick Backup, Program Settings, GPS Interface, and Software
Registration.
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Overview of the Main Menu Buttons

Trip Manager
The Trip Manager is used to manage each trip you take. It combines the
major components of your logbook into a single location. Trip Manager
allows you to:

* Create four types of log entries (General, Maintenance, Fuel, and

Radio) and associate them with your trip.
* Add waypoints to your trip.
e Add passengers to your trip.

General Log
The General Log is used to create the primary log entries for a trip. Each
entry includes the time, date, location, and engine hours.

Waypoint Log

The Waypoint Log is used to create a universal waypoint list. This
universal list can then be accessed via drop-down lists throughout the
program, thus saving a great deal of time repeatedly entering the names
of locations.

Passenger Log

The Passenger Log is used to create a universal passenger list. This
universal list can then be accessed via drop-down lists throughout the
program, thus saving a great deal of time repeatedly entering the names
of passengers and crew.

Maintenance Log

The Maintenance Log is used to record any maintenance performed on
your vessel. In conjunction with the Inventory Log, it is also used to
monitor supply levels.



Inventory Log

The Inventory Log is used to record and monitor a list of boating supplies
and their quantities. It also provides an alert to the user when supplies
run low and offers the ability to print a shopping list.

Fuel Log
The Fuel Log is used to record the time, date, and location of fueling
instances. The log is also used to keep track of fuel expenses and
quantities.

Radio Log
The Radio Log is used to record the time, date, and location of incoming
and outgoing radio calls.

Specifications
Detailed information regarding your vessel, engines, tankage, ownership,
and insurance is recorded in the Specifications Form.

Navigation Rules

The official US Coast Guard Navigation Rules for International and Inland
waters are included, along with Chart #1, which identifies all chart
symbols currently in use on all US charts. Quick access to specific
sections of these documents is provided via a "double click" feature.



Search

The Search feature allows you to find logbook records using names,
locations, dates, and other keywords. The results can then be printed as
reports.

Print Logs

The Print Logs feature allows you to print both blank log pages and
reports.



Toolbar Buttons

The following buttons are located on every toolbar in Ship’s Log:
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Search — allows you to run queries by opening the “Search” form.
Quick List — opens a list of saved logs, as an alternative to scrolling
through these logs.

Copy to Clipboard — copies all information from the current log,
allowing you to paste it into another document.

Print Preview — opens the “Print” form, where you can preview your
log document.

Attached Media — opens the “Attached Media” form, where you can
add files to your log and tag them with searchable keywords.

Links — allows you to associate websites and email addresses with the
current log.

The following buttons are found on select toolbars in Ship’s Log:
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The Shopping List button, found in the Inventory Log Toolbar, allows
you view all “Shopping Enabled” inventory items and to create a list
of products to purchase if and when quantities run low.

The Watch Log button, found in the Trip Manager Toolbar, opens the
Watch Log form, to record who is on watch duty, as well as when,
where, and for what duration of time.

The Open GPS Interface button, found in the Waypoint Log Toolbar
and the Watch Log Toolbar, opens the GPS Interface window.

The Scheduled List button, found in the Maintenance Log Toolbar,
allows you to view and access all scheduled maintenance events in a
single form.

The Next/Previous Interval buttons, found in the Maintenance Log
Toolbar, allows you to move between log entries for a maintenance
task scheduled to repeat at intervals.



Form Buttons

The following buttons are located on specific forms in Ship’s Log:
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The Insert GPS Coordinates button, found on the Waypoint Log form,
downloads the current GPS coordinates into the current log.

The Next/Previous Interval buttons, found on the Attached Media
form, allows you to move between media files.

The External Viewer button, found on the Attached Media form, will
open the selected media file in the default application that has been
linked to this media type.

The External Editor button, found on the Attached Media form, will
open the selected media file in the default application that has been
linked to this file type.

The View in File Explorer button, found on the Attached Media form,
will open the folder where the media file is located. This is
convenient when adding multiple files at one time, or when looking
for related files.

The Rename button, found on the Passenger, Waypoint, and
Inventory forms, opens a dialog window to change the name of the
record. Upon submitting a new name for a Passenger or Waypoint,
you will also be asked if you want the change to effect related log
entries.



Trip Manager

& Trip Manager (146 of 159) - Obstruction Pass Weekend =
«E]p|» ale(allz -lel vew | |wRemove | | Gose |
Trip Mame: Obstruction Pass Weekend | Departure {aaﬂ_} Armival {Destlnatlnn
Comments: Winds wers light, except in Eastsound. Sun was out the whole time and Waypoint: Cap Sante Marina -

the weather was pedect.
Date: Aug 05, 2008 E=

Time: 08:30AM &

Engine #1 Hours:  957.13
Engine #2 Hours:  0.00

!_LU_Q__E_':'t_’i_EE _ml Passenger List |

Trp Waypoint List Amval Infarmation Departure Information
Fosario Resort . Diate: Diate:
Obstruction Pass State Park
Time: Time:
Engine #1 Hours: Engine #1 Hours:
Engine #2 Hours: Engine #2 Hours:

Comments

[ Add | [ Remove | | Edit

Creating a Trip:

* In the Main Menu, click Trip Manager.
* By entering a Trip Name, you will be able to associate future logs with this trip.

* Inthe Comments section, you can enter trip information that would otherwise not be
included in associated log entries.

Departure/Arrival Tab

* Inthe Departure tab, enter or select your point of departure (waypoint), date, time, and
engine hours.




* Inthe Arrival tab, enter or select your final destination (waypoint), date, time, and
engine hours.

* To populate the Waypoint drop-down list, you must enter a new waypoint using either
the Waypoint List tab in Trip Manager, or the Waypoints button of the Main Menu. (see
Waypoint List)

Log Entries Tab

* All four log types found here (General, Fuel, Maintenance, Radio) can be created or
accessed from the Main Menu.

e Ifthe “Log Type” texts are black, then no log of that type is associated with that trip. If
the text is red, then a log of that type is associated with that trip.



The General Log
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\= General Log (57 of 306) [ =[]
) 2] a]s) (e (e |[xRewe | | e |
Log Date:  Aug 15,1938 [E~ Engine #1 Hours: 175.00
Log Time: 0617 FM = Engine #2 Hours: Q.00
Wessel Location: | Liberty Bay Marina =

We took the femy over from Edmonds and onby waited a few minutes. Kids had a great time, as this was their first -
time on a femy!

Left dock and set sail for Blake Island, in light winds. Brian, Tim and Zander took tums at the helm all aftemoon.
Good winds, atthough a bit light. Sailed south along west side of Bainbridge.

Amived at Blake and waited for a power boaterta leave, so we could take his place on the dock. Very nice of them,
as this marina is usually filled to capacity. We tied up boat and walked the beach for a little while. Then we hileed
over to the westem campground. Kids really liked the different "feeling” that this forest had, compared to Denver
and the Rockies.

Left Blake and motored through Rich passage, then sailed north once we were nearthe Port of Brownsville. Amived
at dock before 7:30. Took the femy home. Great day!

| Muthor. | Bonrington, Robert » | Trip Name: | 8/19/1998: Blake Island w/ Ann & Bob ~

Creating a General Log Entry:

* A new general log entry may be created via the Main Menu or Trip Manager:
0 Inthe Main Menu, select General Log.

0 In Trip Manager, select General in the Log Entries tab and click Add. Note:
Creating a log entry within Trip Manager automatically associates the entry with
that trip.

* The Vessel Location drop-down list is populated with locations found in the Waypoint
List. A new location can be added to the Waypoint List by clicking Vessel Location.

e The Author drop-down list is populated with only those passengers selected as “Log
Authors” in the Passenger List. To add a new passenger as an author, enter the person’s
name in the “Author” field and click Author.
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To associate a log entry with a particular trip, select the desired trip name from the Trip
Name drop-down list.

0 Clicking Trip Name will open an associated trip in the Trip Manager.

0 If you do not wish to associate a log entry with a trip, select “No Trip
Association.”
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The Fuel Log

@ Fueling Log (34 of 37) =0 | EoR >
|«H 4 | [ SN 2 |J|E]|—.J||j| ‘n”‘:ﬁ, ‘V'NEW ‘ # Remove | | Close |
Fueling Info
Fueling Date: Aug 16,2008  [E- Total Gallons Added:  9.00 | Cale |
Fueling Time: D4:30 PM o Cost Per Gallon (5);  5.000 | Cale
Engine #1 Hours;  963.35 Total Cost {8):  45.00 | Cale |
Engine #2 Hours:  0.00 Calans Per Hair:
Fueling Location: Cap Sante Marina -

We stopped at the fuel dock in CapSante Marina to top off ourfuel. Price is still 2 bit high, but we arent really using much fuel this summer.  »

Author: | Bonnington, Robert - Trip MName: lE.-"IE.-"E‘DDB: Saturday in Ezstsound -

Creating a Fuel Log Entry:

A new fuel log entry may be created via the Main Menu or Trip Manager:
0 Inthe Main Menu, select Fuel Log.

0 In Trip Manager, select Fuel in the Log Entries tab and click Add. Note: Creating
a log entry within Trip Manager automatically associates the entry with that trip.

In the Fueling Info section, “Gallons Per Hour” can be calculated if a value for “Total
Gallons Added” and Engine Hours for the current and previous log entry are entered.

The Fueling Location drop-down list is populated with locations found in the Waypoint
List. A new location can be added to the Waypoint List by clicking Fueling Location.

The Author drop-down list is populated with only those passengers selected as “Log
Authors” in the Passenger List. To add a new passenger as an author, enter the person’s
name in the “Author” field and click Author.

To associate a log entry with a particular trip, select the desired trip name from the Trip
Name drop-down list.

12



0 Clicking Trip Name will open an associated trip in the Trip Manager.

0 If you do not wish to associate a log entry with a trip, select “No Trip
Association.”
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The Radio Log

-

&b Radio Log (11 of 16) =
«”‘HP »||J“|§J||_J“_—§| - ‘V'NBW HnHemove |Ck:se ‘
Date of Call:  Sep 05, 2004 [El~ Caller
Time of Call:  05:55 PM n | Caller Name: | Bonnington, Robert -

[ Caller Location: | Victoria (Wharf Strest) =
Recipient
| Recipient Mame: | Harbor Master -

e Ty | Recipient Location: | Victoria (Wharf Strest) -

| called the Harbormaster and got an assistant. We were given a berth at the Whar Street docks. One thing | noticed was  «
that the battery power in my hand-held VHF went from about 707 good to 0% good when | tried to transmit. Wil have to
watch that in the future. Will recharge the batteries this week. Meanwhile, | placed the spare AA's into the unit for now.

Since | called from the Customs dock and had the engine off, it was easy to simply rely on the ship’s mdio while | changed

the batteries in the hand-held.

Author: | Bonnington, Robert - Trp Mame: || 5¢/5/2004; Labour Day in Victona -

Creating a Radio Log Entry:

* Anew radio log entry may be created via the Main Menu or Trip Manager:
0 In the Main Menu, select Radio Log.

0 In Trip Manager, select Radio in the Log Entries tab and click Add. Note:
Creating a log entry within Trip Manager automatically associates the entry with
that tri.

* The Caller Name drop-down list is populated with only those passengers selected as
Radio Operators in the Passenger List. A new passenger can be added to the Passenger
List by entering the person’s name and clicking Caller Name.

* The Recipient Name drop-down list is populated with passengers found in the Passenger
List. If you need to create a passenger record, you can enter the person’s name in the
“Recipient Name” field and click Recipient Name.
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The Author drop-down list is populated with only those passengers selected as “Log
Authors” in the Passenger List. To add a new passenger as an author, enter the person’s
name in the “Author” field and click Author.

To associate a log entry with a particular trip, select the desired trip name from the Trip
Name drop-down list.

0 Clicking Trip Name will open an associated trip in the Trip Manager.

0 If you do not wish to associate a log entry with a trip, select “No Trip
Association.”
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The Watch Log

" # Watch Log (1 Entries) E=mr=n <
. e = |
‘ ~ Add I [d‘. Edit ‘ l # Remove | ‘ a | CERNE=] | n ‘ ‘ "] | Poston | Enmmmsstes e el

] I - -
& Date Time Duration Latitude Longitude Speg Watch Date:  Oct 07,2008 [J

12205562 [0 | Watch Tms:  0208PM |4
Watch Duration: |30 Minutes v|

Latitude: 47743 03.21" S

Longitude:  122° 05 56.26" W
Speed {Knots): 0
True Heading:  117.1

. i — Magnetic Heading: 99
o o ] : agnetic Heading

. | St | [30Minute itenval v

Trip Asseciation: Sail to Lake Washington

* The Watch Log, found on the Trip Manager toolbar, can generate a log entry at regular
intervals for those crew members on watch duty.

e Information saved in the Edit Watch Log Entry form will automatically populate the main
Watch Log form.

* The Watch Duration drop-down list, found in both the Edit Watch Log Entry form and
the Position tab on the main form, refers to the duration of time a crew member is on
watch. The Log Interval, found at the bottom of the main form, identifies how often a
new log entry will be created.

* You can download your longitude and latitude by connecting a GPS device and clicking
the Open GPS Interface button on the Watch Log toolbar.

16



The Maintenance Log

¥, Maintenance Log (39 of 178) == EoR| = l
e )r] @z]e)a) e (@« [~ @ | | (e
Log Date: Dec 26,2000 [+ | Schedule | Pats | Cost |
Log Time:  04:26 PM 4 & Part Name Used Cost {5) Commernts
Engine #1 Hours:  362.10 1/2x 1;"2qu. wood dowel 1 ltems 079
C - Clamps 2" 3 lkems 747 Can be used repeatedly on other projects.
Engine #2 Hours:  0.00 Epoxy Glue 1 Bottles 399
Hand Rasp 1 ltems 6.59
Mairtenancs Completion Sandpaper - 120 grit 1 5hests 029 Still have most of sheet Ieft

Completion Date:  [¥]Dec 26,2000 -
Engine #1 Hours:  362.1

bagne HE vz |0 T Edit Remaove

Maintenance ftem: - [ VWork Location: Cap Sante Marina -
Work Type: Part Repair - Performed By: Bob Bonnington -

| drove up to Anacortes, amving about Ipm. First thing | did was to finish pulling the forward water tank. To do this, | removed the remaining vent hose and fill hose from  »
their tank fittings. The tank then lifted out easily. | placed it on the fore deck to hose it off and clean it with Lysol. |then left it on the dock to dry, while | cleaned the

forward V-berth area, including the tank holding area. Once it dried, | also laid some blue non-stick material down, to cushion the tank and prevert it from chafing onthe |-
bare gelcoat. I
Unfortunately, while | was cleaning this forward area, | slipped and damaged the forward V-berth drawer support. This had always been a weak spot, so | decided to ficit
befare | 1=ft.

Meanwhile, az soon as the forward tank was dry, | put new Teflon tape on all of the fittings and tested it. | held water! | then inspected the aft watertank and it also
appeared to be holding water. |then re-nstalled the forward tank and filled both tanks with water. | noticed that there was still a sizeable leak - somewhere in the mid-
.section of the boat. When the water pump was on, it poured fresh water out all over the bilge. | began a systematic search for the leak, but found none. Then | realized _

fatthor; | Bonrington, Robert - Trip Name: || No Trip Association -

Creating a Maintenance Log:

* A new maintenance log entry may be created via the Main Menu or Trip Manager:
0 Inthe Main Menu, select Maintenance Log.

0 In Trip Manager, select Maintenance in the Log Entries tab and click Add. Note:
Creating a log entry within Trip Manager automatically associates the entry with
that trip.

* In the Maintenance Completion section, the Completion Date checkbox should be
selected when a maintenance task has been completed. Note: If the Maintenance
Warning Light is yellow or red, checking the completion date will return the light to its
default green status.

* The “Maintenance Item” field refers to an item on which work is being performed. The
Maintenance Item drop-down list is populated with items you have entered previously,
as well as those items found in the Inventory Log that have the “maintainable” checkbox
selected.

17



0 If a Maintenance ltem already exists in the Inventory Log but does not appear in
the drop-down list, open the Inventory Log and select the “maintainable”
checkbox for that particular item.

0 If you would like to add a new item to the Inventory Log, enter the name of the
item in the “Maintenance Item” field and click Maintenance Item.

The Work Type drop-down list is populated with a list of pre-selected work types. To
modify the list, click Work Type. The Settings form will then open, allowing you to make
necessary changes. Note: You can also open the Settings form directly from the Main
Menu toolbar.

The Work Location drop-down list is populated with only those locations found in the
Waypoint List that have the “work location” checkbox selected.

0 To add a new work location to the Waypoint List, enter the location in the “Work
Location” field and click Work Location.

0 If the desired location already exists in the Waypoint List, identifying that
location as a “work location” will add it to the Work Location drop-down list.

The Performed By drop-down list is populated with the names of passengers found in
the Passenger List. If you need to create a passenger record, you can enter the person’s
name in the “Performed By” field and click Performed By.

The Author drop-down list is populated with only those passengers selected as “Log
Authors” in the Passenger List. To add a new passenger as an author, enter the person’s
name in the “Author” field and click Author.

To associate a log entry with a particular trip, select the desired trip name from
the Trip Name drop-down list.

0 Clicking Trip Name will open an associated trip in the Trip Manager.

0 If you do not wish to associate a log entry with a trip, select “No Trip
Association.”

18



The Schedule Maintenance Tab:

Scheduled Completion. ..
Date: Jun 27.2009 [E~ Waming: 0 Days

Engine Hours: 1400 hours an | Engine #1 - Waming: 1600 Hours

Scheduled Interval

[ Time Period [] Blapsed Engine Hours

[wT]

e

1

If you wish to monitor the completion of a maintenance task, use the “Scheduled
Completion” section. The completion deadline may be designated by a specific date or
a specific engine hour.

If you select the Date checkbox, enter a calendar date for completion. To receive a
warning of the approaching deadline, enter a number of days in the “Warning” field.

If you select the Engine Hours checkbox, enter a specific engine hour by which the task
must be completed. To receive a warning of the approaching deadline, enter a number
of engine hours in the “Warning” field. Current engine hours are identified, based on
engine hours reported in the most recent log entries.

Maintenance Warning Light — Found on the Maintenance Log toolbar, the warning light
monitors the pending completion of a scheduled maintenance task.

Color Meaning

0 —  For a scheduled completion deadline, the designated
warning period has yet to occur; or
— Neither of the two Scheduled Completion boxes are
checked; or
— The Maintenance Completion Date box is checked.

(D — The scheduled completion deadline is approaching
(based on the warning period has been entered).

0 — The scheduled completion deadline has passed.

19



* If you wish to schedule periodic maintenance, use the “Scheduled Interval” section.
There are two methods of scheduling periodic maintenance: by Time Period, or by
Elapsed Engine Hours.

0 If you select the Time Period checkbox, enter the desired time interval for
periodic maintenance. The drop-down list provides a list of time units.

0 If you select the Elapsed Engine Hours checkbox, enter the desired engine hour
interval for periodic maintenance. The drop-down list allows you to set an
interval for either Engine 1 or Engine 2.

The Parts Tab:

¥, Add Part [ES e

Part Information Cost

Part Name: !Oil Fitter ¥, | | Open Inventary Log -

|¥| Calculate From Inventony

Commerits:

| = Total Cost () 666

Total Part Count: 2
Inventory Reference
Quantity Used: 2 [EJ|:| Units
& Quantity Used Quantity On Hand Quantity Purchaged Purchased Purchase Location
2 0 4 B/5/2008 Safeway
# i 3
| v Ok ‘ ‘ # Cancel |

e If parts are necessary for the maintenance of an item, select the Parts tab in the
Maintenance Log and click Add.

* Inthe Add Part form, select the desired part from the Part Name drop-down list. The
Part Name drop-down list includes all items found in the Inventory Log.

0 If adesired part is not found in the drop-down list, click Open Inventory Log to
create a new Inventory record for that part. The part then be added to the Part
Name drop-down list.

e If an item was acquired on multiple occasions (as recorded in the Inventory Log), you
will see each of those instances listed in the Inventory Reference section at the bottom
of the Add Part form. For example, if you purchased oil filters on three different
occasions, you should see those three instances listed at the bottom of the form.

20



* Before entering a value in the “Quantity Used” field, be sure to first select (highlight)
one of the listed items in the Inventory Reference section.

*  When a part is added to the Maintenance Log, the quantity used will be accounted for in
the Inventory Log. Note: If a Maintenance Log is deleted, the quantity of used parts
associated with the log will automatically be returned to Inventory.

The Cost Tab:
Schedule | Pats | Cost
Labor Hours: 40 Calc Parts Cost: 135.84 Calc
Cost Per Hour:  25.00 Calc Other Cost:  23.22 Cale
Total Labor Cost:  1000.00 Calc Tax: 10.00 Calc

Total Work Cost:  1169.06

* The Cost tab allows you to calculate the various costs of a maintenance task. For
example, if you enter Labor Hours and Cost Per Hour, clicking Calc will calculate the
Total Labor Cost.

e Clicking Calc next to the “Parts Cost” field will total the cost of all parts listed in the Parts
tab of the Maintenance Log.

21



Waypoints

r Waypoint (1 of 6] - Blake Island - Northwest Moorage E
M ] 2] o) e[ B] [y |[|sRmee | | cee |
Waypoint Name:  Blake Island - Northwest Moorage & |
Show in Drop-Diown Lists
|7] Fueling Location [7] Work Location
Coordinates
Latitude: Longitude: ‘ ‘
Comments

Thig is the "protected” side of the island. No fery wakes or wind waves. Mooring is accomplished either by anchoring -
{good sand/mud bottom) or by making fast to @ "mooring line” that is strung between two pilings. This actually works

pretty well, as it allows vessels to be moored on both sides.

State park on the island has some facilties {a water facet and one toilet each for men & women), but they are limited. The
campground and beach are very relaxing and private. This would be a great place to spend a few days writing, reading,

fishing, crabbing and watching nature!

Creating a Waypoint:

A new waypoint can be created via the Main Menu or Trip Manager:

0 Inthe Main Menu, select Waypoints.

0 In Trip Manager, select the Trip Waypoints tab and click Add. Then, in the

opened Add Trip Waypoint form, click New.

A new waypoint can also be created by renaming an existing waypoint.

0 Inthe Waypoint form, select the Rename button to the right of the Waypoint

Name and you will be prompted to assign the new waypoint name.

0 After assigning the new waypoint name, the program will ask whether you want

the new name to replace the old name in all related log entries.

After adding a new waypoint name, select any applicable checkboxes for displaying the

waypoint in drop-down lists.

Coordinates are given in standard degrees, minutes, seconds. You can import latitude
and longitude data from a GPS device by clicking the Insert GPS Coordinates button on

the form. (see Using a GPS Device)

Keep in mind: When you return to the Waypoints List, all records will be organized

alphabetically.

22




& Add Trip Waypoint = |[E =S

Waypoint Name: [Gan‘ison Bay v] [ Edit ] [ Mew l
Amival Departure
Date: Oct 02,2008 [E~ Date: Oct 08,2003 [E~
Time: 02:41PM 5 Time: 0420PM 5
Engine(1) Hours: 130.3 Engine({1) Hours: 1303
Engine(2) Hours: 0 Engine(d) Hours: 0
Comments:
Picnic with the kids. -

[1” Add to Trip l [ﬁ Cancel

Adding Waypoints to a Trip:

* Inthe Trip Manager, select the Trip Waypoints tab and click Add.

* Inthe Add Waypoint form, select a waypoint from the Waypoint Name drop-down list.
The drop-down list is populated with all locations found in the Waypoint List.

23



Passengers

P

a Passenger (4 of 115) - Bonnington, Charlie = |- = | ]

IR CIE EIEYENC

2

‘fhlew ‘ ‘nﬂemn'u'e ‘ ‘ Close

General | Experience | Contact Information | Medical/Dietary Needs | Emergency D::ntad|

Mame

Mame: Bonnington, Charie Fay

Title: Mickname:

Show in Drop-Diown Lists
[ Log Author [ Radio Operator

General Comments

Charlie has plenty of experience in past years. He can be counted on to act competenthy as crew and evento =
take over as captain, in a pinch.

Creating a Passenger:

* A new passenger entry can be created via the Main Menu or Trip Manager:
0 Inthe Main Menu, select Passengers.

0 In Trip Manager, select the Trip Passengers tab and click Add. Then, in the
opened Add Trip Passenger form, click New.

* A new passenger entry can also be created by renaming an existing passenger.

0 Inthe Passenger form, select the Rename button to the right of the Passenger

Name and you will be prompted to assign the new passenger name.

0 After assigning the new passenger name, the program will ask whether you want
the new name to replace the old name in all related log entries. If existing log

entries call out Jane Doe, but she is now married and her new name is Jane
Smith, you would probably not want to update the historical entries.

-

e After adding a new passenger name, select any applicable checkboxes for displaying the

passenger in drop-down lists.

e Keep in mind: When you return to the Passengers List, all records will be organized
alphabetically.
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& Add Trip Passenger E@

Create Mew Fassenger

Sorted by: Last Mame -

Kate

Melanie

Mike

Rachel

Tim =

4 [Tl b

|1"AddtuTrip | |n Cloze

Adding Passengers to a Trip:

* Inthe Trip Manager, select the Trip Passengers tab and click Add.
* Inthe Add Passenger form, select a passenger from the Passenger Name drop-down list.

0 The drop-down list is populated with all persons found in the Passenger List and
can be sorted by first or last name. To sort, click the “Sorted by” column header.
Once a passenger has been added to the Trip Manager, their name will no longer
appear on the Passenger Name drop-down list for that particular trip.

* You can add multiple passengers to a trip by selecting (highlighting) several names at
once from the Add Trip Passenger form. To highlight multiple names, hold Ctr/ and click
on the desired names.

* To create a new passenger, click Create New Passenger.
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Vessel Inventory

& Inventory Log (82 of 152) - Life Sling [l [ (3]
W) @ER]E) e =) @ [ten | [somme | [ |
ftem Name:  Life Sling | % |
Category:  First-fid / Emergency - Last Audit Date:  Jul 13,2008 [+ Characterstics
[V] Safety tem
Unit of Measure:  tems - Quantity on Hand: S
| Maintainable
Recommended Purchase Quartity: a [F] Corsmabie
Comments:  Forrapid deployment, this flotation device has a tether. To throw, simphy pull from box . [ Perishable
This lfe-sling replaced our old horseshoe buoy that was finally eaten away by UV S
EXDOSUTE .. L |¥| Shopping Enabled
GQuantity Waming Expiration Waming
[¥] Enable Quantity Wamings [7] Enable Bxpiration Warmings
Minimum Required; 0 units
Quartity Waming; 0 units from minimum.
Aoguisttion History
& Purchaze Date Quantity On Hand Quantity Purchased Purchase Location Individual Cost () Total Cos
8/10/1956 0 1 West Marine 80.00 8l
6/1/2008 1 1 West Marine 108.00 104
i T }
ol % Bomove. | | &8 Edt [¥] Show Consumed tems
-'i'atal Fosailable: 1 Total Purchased: 2

Creating an Inventory Item:

* A new inventory item can be created via the Inventory Log:

0 From the Main Menu, select Inventory, or from the Add Parts window (on the
Maintenance form), select Open Inventory Log.

0 Inthe Inventory from, click New.
* Anew inventory item can also be created by renaming an existing inventory item.

0 Inthe Inventory form, select the Rename button to the right of the ltem Name
and you will be prompted to assign the new inventory item name.

0 After assigning the new inventory item name, the program will ask whether you
want the new name to replace the old name in all related log entries.
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* To add or remove categories from the Category drop-down list, go to the Main Menu
Toolbar. Click Options > > Tables > Category Type.

* To add or remove units of measure to the Unit of Measure drop-down list, go to the
Main Menu Toolbar. Click Options > Settings > Tables > Units of Measure.

* There are five checkboxes in the Characteristics section by which you can describe the
inventory item.

0 If the “Maintainable” checkbox is selected, the item will appear in the
Maintenance Item drop-down list.

0 If the “Shopping Enabled” checkbox is selected, the item will appear in the
Shopping List form.

e Each time you verify the status and quantity of an inventory item on your vessel, be sure
to update the “Last Audit Date” field in the Inventory Log.

* The “Quantity on Hand” value, which represents the number of units available for use,
can be changed in three ways:

0 Inthe Add Acquisition History form, changing the “Quantity Purchased” value
will also change the Quantity on Hand.

0 Inthe Acquisition History tab, you can select an acquisition record and use the
Decrement button to decrease the Quantity on Hand.

0 Inthe Maintenance Log, using an inventory item for parts will decrease the
Quantity on Hand in the Inventory Log.

Creating an Acquisition History Record:

e Each time you acquire an inventory item, you should create a record in the Acquisition
History section of the Inventory Log. Clicking Add will open the Add Acquisition History
form where you can enter further details of the acquisition.

* Inthe Add Acquisition History form:

0 Ifanitem is used for maintenance (as recorded in the Maintenance Log), the
“Used for Parts” field will reflect the amount used.

0 Note: If you wish to reduce the Quantity on Hand, it cannot be done in this form.
To do so, you must return to the Inventory Log form, select the record from the
Acquisition History tab, and click Decrement.

0 When you are finished creating an acquisition history record, the new entry will
be listed in the Acquisition History tab (at the bottom of the Inventory Log form).
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& Edit Acquisition History {Batteries - CR123)

||:|||E| ﬂ_h‘

Furchase Location:  Cther

Maintenance Relationship

Cuantity
Quantity Purchased: 32

Quartity On Hand: 3

Acquisition Comments:

Storage Location:  Forward port locker in the salon.

|Ised for Parts:

1

4

Purchase Date:  [¥] Jun 20, 2007 [E~

Exiration Date: [¥] Jul 06, 2017 [E

[nits

Furchase Cost
Per Lnit Cost (3):

Total Purchase Cost (8

5.00

15.00

These batteres came from FourSeven’s, as part of a flashlight acquistion.

| | Cancel

Monitoring Inventory Levels:

* To create a warning level for an item, select the “Minimum Quantity Required”

checkbox in the General tab.

* Inventory Warning Light — Found on the Inventory Log toolbar, the warning light

monitors both inventory levels and expiration dates.

0

olo

-

Meaning

® © 0O

— The inventory level is below the Minimum Quantity
Required.
— The expiration date has passed.

— The inventory level exceeds the Quantity Warning level.
— The item is not near expiration.

The inventory level is below the Quantity Warning level
but not below the Minimum Quantity Required.
— The expiration date is nearing, but not yet passed.

e If you move the mouse cursor over the warning light, a message will appear describing

the reason for the warning.



* To set a default “Expiration Warning” and “Quantity Warning” value, go to the Main
Menu toolbar and click Options > Settings > Warnings > Inventory Alarm Defaults.

=] Shopping List = e )
[¥] Shaop for Critically Low kems Only Close Shopping List |
& Quarntity To Purchase ltem Name Last Audit Quantity On Hand Mirvimrm Gual‘rtit)'|
0 tems Batteries - 4D 7/8/2003 2 tems 1 kems
0 tems Emergency Fa... 77242004 8 ttems 4 tems
0 tems Fire Bxdinguish...  9/21/1998 2 tems 1 tems
[ Packages Batteries - D 5/20/1958 3 Packages 2 Packages
0 Quars Transmission F...  9/23/15958 0 Quarts 1 Cuarts
2 ttems Raw Water Im...  10/25/2005 1 kems 1 kems
o mr 2
Select All
Minimum Purchase Quantity: Units
Quartity Needed: Units
Guantity On Hand: Units
Guantity to Purchase: Units
=4 Print Preview
The Shopping List:

* The Shopping List, found in the Inventory Log Toolbar, allows you to view all inventory
items that are "Shopping Enabled" and to create a list of products to purchase if and
when quantities run low.

e For an inventory item to appear on the Shopping List, you must select the “Shopping
Enabled” checkbox on the Inventory Log screen.

* To calculate the necessary Quantity to Purchase, select (highlight) an item from the
shopping list and click Calculate Quantity.

* To show only those items with a Criticality label of critical or warning, you must select
the “Shop for Critical Items Only” checkbox.

e To print a shopping list, highlight the desired inventory items and click Print Preview.
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Searching for Logbook Records

One of the most powerful features of Ship’s Log is its ability to search for and retrieve logbook
records instantly.

¥ ~ Search Logbook El
Search For. .. Search Criteria
(71 Trip Logs @ Show results that match any selected filter ("1 Show results that match all selected fiters
1 Watch Logs

) [ ‘Log L betwsen Oct 08,2009 [J+ and Oct 08,2009 [0+
| Passenger Descriptions

F) Wi Descriptions [ between 07:45 AM & and  01:49 AM
Inventory ftems - tem  having the words T
) General Logs o -

: |=] Work Type  having the words -

@ Maintenance Logs
© Raiio Logs [T Work Location  having the wonds -
1 Fuel Logs [ ‘Wor Pedfomed By hd
[7] Scheduled for |neitherdate, nor engine hours v|
| | thatis |period1'c {by Time or Engine Hours) vJ

nDate between Oct 08,2009 [Elv and Oct 08,2003 [E+
[ Completion Status  thatis |notye¢ complete hd
having the words -

[T Comments  having the words

I Author  named -

[ Trip Association  named A4

[l Picture |keyword5 v| having the words hd
| L, View Resutts ‘ ‘ Cloge ‘

Performing a Search:

1. Inthe Main Menu, click Search. Alternately, you can click on the Search button in the
header of any open log window.

2. Select the type of record you are interested in retrieving.
3. Select the checkboxes of those filters that you wish to use in your search.

4. Choose how you would like to apply your selected filters. If you wish the search results
to match:

a. All of the checked filters, select “Show results that match all selected filters.”
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b. One or more of the checked filters, select “Show results that match any selected
filter.”

5. Click View Results to open a list of all records returned from your search.

Generating Reports:

1. Select (highlight) those records you wish to include in a report.
2. Click Preview Report. Areport is then generated and opened for printing.

3. For a Trip Report, select the checkboxes of those logs/lists you wish to include in the
report.
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Printing Logs & Reports

Ship’s Log allows you to create unlimited numbers of traditional, paper logbooks. You can
customize each logbook by choosing from any of the twelve log forms found in the program.

To Print Blank Log Pages:

In the Main Menu, click Print Logs.
Select the Blank Log Pages tab.

Click on one of the log page buttons.

A w N e

When the preview window has finished
generating the report, you can print the
blank log page (s).

In addition to blank log pages, Ship’s Log also
offers ten customizable report options for
printing.

To Print Reports:

In the Main Menu, click Print Logs.
Select the Reports tab.

Click on one of the report buttons.

Ll L

In the Search Results form, select
(highlight) those records you wish to
include in your report.

5. To open the selected record for viewing,
click Open Selected.

6. To print the selected record(s), click
Preview Report.
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Using a GPS Device

Data from your GPS device can be downloaded to Ship’s Log and used for entering accurate
waypoint information.

ViEWing GPS Data: | GPSInterface =] = |

GPS  Settings

1. After opening Ship’s Log, connect the GPS
device to the computer and power it on.

Latitude: 47" 43 085" N
Longtude: | 1227 0% 563" W
2. On the Main Menu Toolbar, click View > GPS Speed: |0

Interface. This opens the GPS Interface form. Time: | 08:35:54 FM
. . Date: | 10/07/2005
3. Torecognize your device and download data,

] True Heading: |07
click GPS > Connect.

Magnetic Heading: |341.5°

a. Note: The status of the GPS device will Magnetic Offset: |-18.1°
be displayed as Connected or Satellite Court: |10
Disconnected at the bottom of the form. Signal Precision: | Very Good

4. Once connected, information should appear in Connected: COMS (4800 baud)

the fields of the GPS Interface window. If no
information appears in the window, or the status indicates a disconnected GPS device:

a. Check that the GPS device is turned on and that it is properly connected to the
computer.

b. Check that the GPS device has acquired the necessary number of satellites for
determining your position.

C. Go to the Main Menu Toolbar. Select Options > > GPS. Check that the GPS Port
connection is correct.

Downloading GPS Coordinates to a Waypoint:

* In the Main Menu, open Waypoints, then select the appropriate Waypoint record.
e If adding a new Waypoint record, select New from the Waypoint Toolbar.
e On the Waypoint form, click the Insert GPS Coordinates button.

* |If a GPS device is connected, the longitude and latitude will automatically be entered
into the form.

e If a GPS device is not connected, the GPS Interface window will open. If this occurs,
refer to the steps for “Viewing GPS Data” above.
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Attached Media

[wa ]|£3.Ed'rt ||;‘\-Ha'nuve l

Anacortes
Tug Boat
Dock
Birds
Might

ChUsers\Mark\nb38784273 149634 _5158.jpg

Any type of file—picture, video, audio, or document—can be attached to your logbook records.
You can apply keywords to attached files so that associated logs can be found quickly using
Ship’s Log’ Search function.

As you work with the Attached Media form, please keep the following in mind:

* The Attached Media form will display a preview thumbnail for supported picture files;
however, other file types cannot be previewed and are instead represented by a
placeholder thumbnail.

* Double-clicking a thumbnail will refresh the image.

e Ship’s Log stores the locations of attached media, but not the actual source file. If the
original file is moved to a new location, Ship’s Log will ask you to locate it.

* Attached media files will only be associated with the log to which they are added.
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Adding and removing media Comments and Keywords:

Comments and Keywords can associated with individual media files, to capture user-specific
information. They can also be used as search arguments, to quickly locate specific media.

e To add, revise or delete a comment associated with a particular media file, select that
media file, then select the Comments tab and update as required.

* To add a keyword to the selected media file, select the Keywords tab, then click the
New button to open the Add Keyword window.

* To edit an existing Keyword, select the keyword to be modified and click the Edit
button. The Edit Keyword window will open.

Edit Keyword (3]

Update every occurance of this keyword in the logbook.

New Keyword

Cancel

0 To update all occurrences of the keyword, select the checkbox at the top of the
window, enter the new keyword value and click OK.

0 To update only the one occurrence of the keyword, leave the checkbox empty,
then enter the new keyword value and click OK.

* To delete a keyword, select the Keywords tab, then click the keyword to be deleted,
then click on the Delete button.
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Settings

E Ship's Log - Settings

El

-GPS

Environmert
- General
- Toolbar
- Reports

- Tables

- Wark Type (Maintenance)

- Units of Measure (Inventory)
- Purchase Location (lnventory)
& Category Type (Inventory)

- Crew Position (Passengers)
‘... Connection

Wamings

- General

- Inventary Alarm Defaults
- Inventary Status

- Paths

- General

- Acrobat Reader
- Media

- Media Types

- Measurements

- Currency
- Fuel
- Time

Apply ][ Cancel

Tables: Category Type {Inventory)

= lE =

Add ] [ Remaove

Load Original Settings ]

Batteries
Beverage

Boaks

Charts

Cleaning Supplies
Clothing
Communications
Cordage
Electrical

Engine
Entertainment
First-Aid / Emergency
Fizhing

Flashlights

Food

Fuel

General

Ground Tackle
Mairtenance
Paper Products
Plumbing

Rigging - Running
Rigging - Standing
Sails

Tools

Water

rs

m

Managing Settings for Multiple Logbooks

If managing multiple vessels, individual logbooks will be assigned to each vessel. The

settings for Environment, GPS, Warning, Paths and Measurements will persist between all
logbooks. As an example, if you choose to display Liters for fuel measurement, that same
display option will be used for all other logbooks. The Table values, on the other hand, will
remain unique to each logbook.

Environment

General

Toolbar

36

“Show Helpful Popups” — Information will be displayed when the mouse is hovered over
certain buttons.

“Show Date Popups” — Extended date information will be displayed when the mouse is
hovered over date controls.

“Show at startup” — The toolbar will load when the program is first opened.




* “Always on top” — The toolbar will remain in the foreground, even when other windows
have focus. This setting can also be implemented from the toolbar menu (Options >
Toolbar > Always On Top).

Reports & Blank Logs

* “Show anchors in report header” — Decorative anchors will display on printed reports; if
unchecked, reports will be produced without any additional pictures. If your computer
has difficulty generating reports quickly, removing the anchor images might improve the
rendering speed.

e “Always open reports in a new window” — Report s will open in new windows; if
unchecked, opening a new report replaces a previously opened report.

Tables

Work Type

* Values entered in this table will be displayed in the Work Type drop-down field on the
Maintenance form.

Units of Measure

* Values entered in this table will be displayed in the Unit of Measure drop-down field on
the Inventory form.

Purchase Location

* Values entered in this table will be displayed in the Purchase Location drop-down field
on the Inventory form.

Category Type

* Values entered in this table will be displayed in the Category Type drop-down field on
the Inventory form.

Crew Position

e Values entered in this table will be displayed in the Crew Position drop-down field on
the Passenger form.

GPS

Connection

* Port - provides a list of COM ports that are available on the computer. When a GPS
device is connected to the computer (via USB or a Serial Port), a COM port is created
that allows communication with that device. Select the correct COM port for your GPS
device.

e Refresh Port — refreshed the list of available COM ports. If you do an Auto-locate search
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for the GPS device, the search will automatically update the available COM ports for

you.

Baud — provides a list of common baud rates. Baud rates represent the speed at which
data is transferred between two devices (in this case, the GPS device and the computer).
GPS devices typically use a baud speed of 4800, but some GPS devices are manufactured
to use other speeds. Refer to your GPS device's specifications to determine its proper
baud speed; you may also try doing a "deep search" to find the attached GPS device
regardless of its baud speed.

Auto-Detect GPS Port — opens a window that allows you to search for GPS devices
connected to the computer. Two search methods are provided:

0 Quick Search —looks for GPS devices that use the same baud speed that you've
already identified in the GPS Baud field. This is useful if you've had a GPS device
connected in the past but the COM port has changed. COM ports can change
depending on how the operating system allocates them. Often, plugging the GPS
device into a different physical port on the computer will change the COM port
assignment for that device. Also, connecting other external devices to the computer
can shift COM port assignments.

0 Deep Search — looks for GPS devices on all COM ports, and will also check a variety
of different Baud speeds. Because so many different connections are made, this
search method can be somewhat slow. If you are attaching your GPS device for the
first time, this search is probably the best one to use since it will find the best baud
speed for your GPS device.

When a search is made, COM ports that were found to have GPS data will be
shown in a list. You can then select a device from the list. If non-GPS devices are
attached to the computer, that are sending data similar to a GPS signal, it will
also show on the list. If your selected device does not transmit GPS data, try
running the search again and select a different COM port from the results list.

If no COM ports are returned in the search, then no GPS signal was found on any
port. Try running the search a second time, in case the port was only
experiencing a temporary halt in data flow. If a second search does not find your
device, verify that your GPS device is turned on, that it is configured to output
NMEA data (check your device's instruction manual), and that it is plugged into
the computer. If you are using a serial to USB adapter for your GPS device, you
might also need to verify that the adapter's driver software has been properly
installed on your computer.
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Warnings

General

*  “Warn before closing the program” — When the program shuts down, a message box
opens allowing you to cancel the shutdown process.

* “Warn before deleting log entries” — When the program deletes a log entry, a message
box opens allowing you to cancel the deletion process.

e “Warn before deleting media items” — When the program deletes a media item, a
message box opens allowing you to cancel the deletion process.

e “Warn before deleting media keywords” — When the program deletes a media keyword,
a message box opens allowing you to cancel the deletion process.

Inventory Alarm Defaults

* Expiration Warning — This field sets the default time period as a warning for inventory
items approaching their expiration date.

* Quantity Warning — This field sets the default value as a warning for inventory items
approaching low quantities.

Inventory Status

e  “Show inventory status only if there is a warning” — The green inventory warning light
will not be displayed. This setting applies to the inventory status shown on the
Inventory Log, as well as the optional inventory status that can be shown on the main
form.

e  “Show inventory status on the main form” — A status symbol will be displayed in the
lower right corner of the main form, allowing you to see inventory levels when the
program is first opened.

Paths

General

e Quick Backup Path — Select the path where you would like to back up your logbook.
Acrobat Reader

e Acrobat Reader Path — Select the path to a preferred program for viewing PDF files. If
you don't have a program to view PDF files, install Adobe Acrobat Reader and then set
this to the Acrobat Reader executable (typically named "AcroRd32.exe" or something
similar).

Media

* Media Path — Select the path where your media files are stored. If you do not have a
preferred location for your media files, or if you are opening media files from a large
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variety of locations, you can check the option: "Open to the most recently used path,
rather than the default media path."

Media Types

File Extension — You will need to add a file extension for each type of media with which
you plan to work. When you select the file extension in the drop-down list, the other
Media Type fields (Media Description, Viewer, and Editor) are updated to coincide with
the selected file extension.

Media Description — Use this field to describe the type of media that belongs with the
selected file extension.

External Viewer — Select the path to the program you plan to use for viewing files of the
selected file extension. If you have already identified a program for one file type, it will
be available in the drop-down list so that it can quickly be selected for other file types.

External Editor — Select the path to the program you plan to use for editing files of the
selected file extension. If you have already identified a program for one file type, it will
be available in the drop-down list so that it can quickly be selected for other file types.

Measurements

Currency

Fuel

Time

Currency Symbol — The default symbol used in financial fields. Changing this symbol
does not change the monetary values in any fields; it is only symbolic and no currency
conversion takes place.

Fuel Measurements — Gallons or liters can be selected as your preference. If you change
the default measurement, a conversion between gallons and liters will be performed so

that your old data fits the new measurement type. Due to the imprecision involved with
mathematical rounding, some of your converted values may not be perfectly accurate.

Time Measurements — Standard (AM/PM) or military (24 hour) time can be selected as
your preference. If you change the default measurement, a time conversion will be
performed so that your old data fits the new measurement type.
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Attached Media, 35, 36
Settings, 40, 41
GPS
Adding as a Waypoint, 33
Settings, 38, 39
Toolbar Button, 6
Viewing GPS Data, 33
Installation, 2
Upgrading Logbooks, 2
Logs
Fuel, 4, 12
General, 3, 10

Inventory, 3, 4, 18, 20, 26, 27, 28

Acquisition History, 27
Shopping List, 29
Warning Lights, 28
Maintenance, 3, 17
Warning Lights, 19
Passenger, 3, 24
Adding passengers, 24
Radio, 4, 14
Watch, 16
Toolbar Button, 6
Waypoint, 3, 22

Adding from GPS, 16, 22, 33
Adding waypoints, 22, 23

Navigation Rules, 4
Printing
Blank Logs, 5, 32
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